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Medication Reviews - Alberta

This document outlines how to configure Medication Review functionality in Kroll and the
process of completing Medication Reviews for both paper based and electronic records.

Configuration

This section explains the configuration settings that must be in place before attempting to use
the Medication Review functionality.

Configuring Electronic Signatures

NOTE: Only complete this section if you are using Electronic Signature pads.

Before you can begin configuring electronic signatures, Allow Electronic Signatures must be
enabled in File > Configuration > Kroll > Configuration. This will require a support call and must
be completed before proceeding.

o Kroll Configuration Parameters |,E.|Lﬂ_hJ
General Qonfiguration| Modulesl IherapeuticAdvisorl gtationl Logging|

I Allow Electronic Signatures I Follow Provincial Legislative Rules for Fx Transfer
[C] Enable SetLaser labels
[T Allgw NDC

1. Go to File > Configuration > Store > General.

2. Place a checkmark next to Allow Electronic Signatures.

%’ Store Level Configuration Parameters E XS
General Patientl Dirug | Doctorl R | FDE I Adiudicationl Labelsl Heportsl Securityl Interfacesl Drderl X-AFll ¥ -Ta Do| Ectrl E)|
Allovs User Colars |:| Alvays Show Scan |:| Digplap window When S ervices are Down

Allws Column Canfiguration Frompt ta exit when clozing fill application Usze autornatic capitalization

Enable MH / batzh . . O
Usze Unit Dose Packaging Allaw Electranic Signatures I
Default language | Endlish J Default area code Enable Crl-FrintS creen ta Print Screenshot
Default Country - Canada ﬂ Sart Fix Transfer Stores By Store Mame j

Stare Information

3. Click OK to save the changes.
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Configuring Electronic Medication Reviews

1. Go to File > Configuration > Store > Rx > Counseling > Med Reviews/Dialogs.

= 22

w* Store Level Configuration Parameters

| Generall F'atientl Dirug | Doctoll Rz I FDB I Adiudicationl Labelsl Heportsl Securityl Intelfacesl Drderl X-AH' ¥ -Ta Dol [BCtrI B
| 1-General| 2- Pricing| 3 - Prompting| 4 - Nursing Home | 5 - Background Fix Filing| 6 - warkflow| 7 - Counseling] & - CeRy

Fix Courizeling Autamatic Patient Counseling

Allows editing counseling time On Mew R

Fequirs Electronic Signature Only flag if patisnt hasn't had the drugin the last 180 days
Uszers Pemitted to Finalize Accepted Counzeling [T] On Fefills

Pharmacist Licensed Technician [Z] On Drug Changes

Pharmacizt Intem Pharmacy Tech Student Allowe Uger to Turm OFF Automatic Counzeling for an Bx
Phamacy Student Pharmacy Assistant
IT Suppart

“izible Tabs
Hardzopy Tab Fx Images Tab
Rx Tab warkflaw Tab
Financial Tab Packaging Tab

Med Reviews/Dialogs

Require Document Scan to Complete Paper Med Review
Enable Electronic Med R eviews

Require Electronic Signature

Allave Editing Counseling Time

s

2. Inthe Med Reviews/Dialogs area above, ensure the following options are set appropriately.

Require Document Scan to Complete Paper Med Review: this option allows you to
complete paper-based Medication Review using the document scan functionality;

e Enable Electronic Med Reviews: enabling this option allows you to use the electronic
version of Medication Review;

e Require Electronic Signature: enabling this option prompts for electronic signatures
where necessary (only if you are using Electronic Signature pads).

e Allow Editing Counseling Time: this option allows you to modify the system-calculated
amount of time it took to complete the counseling session.

3. Click OK.
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NOTE: If you turn off the Require Electronic Signature option and keep the other options
enabled you will still be able to complete the reviews on-screen. However, you will need to
print the report, in order to capture pen-to-paper signatures and then scan it back into the
system before giving it to the patient.

Electronic Medication Reviews

This section explains how to perform an Electronic Medication Review. Ensure your system is
configured for Electronic Medication Reviews before proceeding. See Paper Medication Review
for information on the non-electronic process.

NOTE: The automatic prompts will not appear if the patient does not meet the criteria for a
Medication Review. However, based on other available information and your professional
judgement, you can determine whether the patient might benefit from a Medication Review
and then manually create a Medication Review.

Configuring the Medication Review Prompt

The system prompts for Medication Review when the option Prompt for Medication Review is
enabled under File > Configuration > Store > Rx > Prompting.

o Store Level Configuration Parameters [E“él

| Generall Patientl Dirug | Doct0r| R | FDB | Adiudicationl Labelsl Heportsl Securit_l,ll Interfacesl Dlderl X-AHI Y -To Do| [ECtrI E

1- Generall 2 - Pricing| 3~ Prompting| 4 - Nursing Homel 5 - Background Rx FiIIingI E- W'orkflowl 7- Counselingl 8- Cth<|
Drug Programs

Frompt ta use Drug Subs [T Automaticaly use Drug Subs [ Participate in the Rz Canada / Health Infarm Pragram

Usge Drug Subs when B atching

Prompt If Doctor Refused Repeat Wwhen Canceling R [] Participate in the Pharmacy Access program

Prompt for Comments when Cancelling an Ry [] Use Station Mame Subdirectaries For Pharmacy Access
[ Asherayps require comment Days Back: 365

[ Prampt for Comments when Inactivating an Rx [] Enable Rx Canada Frogram [RxGateway)

[ Alwaps require comment
[ Prampt for Patient Counzelling an new Rx Services o § . )
7] Prompt to Batch NH Fis [] Prompt ta Erral Patients in Refil Remindsr ar Auta Refil Pragram

R ) . ) . Prompt ko Exrol MH Patients in Refill Reminder or Auto Refil Program

gmmpt :_“'he': nat dlsssgsmgcas C_"l@S PF?Ck Size Prompt to Enable Rxs for Refill Reminder and Auta Refil Program
W t b . . -
fompt Fornepeats er.1 oppIng an fik . Enrol Patients for Pickup Motification Mo ﬂ
Prompt To Use Manual Price From Last Refill

[] Fiemave Manual Price far Batched Fixs Enrol MH Patients for Pickup Motification Mo ﬂ

[ Prampt if Doctor Authorization Received for Narcotic Rxs

[ Check for High Intenzity Drugs Frampt to copy workflow packaged info for cancel and refill Rus
Frompt if there iz not enough inventary to fill the Rz Frampt to copy to new number if refiling an Fis with no repeats

[ Prevert Copying an Inactive R ta a Mew Mumber [ Prompt far Due Date an autafil batches

[ Show local patient profile on Fill [ Prompt far Tx comment an autafil batches

Prompt to Copy "Mistake" Rus to a New Number Save Route code from Rix az default value if no default iz set Ak ﬂ

[ Shaw thermal/dat matri label canfig an autafil
Save Form code from Aix as default value i no default is set Ask j

[ Prampt ta Print Script Image far 13t Fill of an Unfiled R=

[ Prarnpt far AADL Plan Infarmation iS4 number iz MOT sst |. F'romlt far Medication Heviewl

[ Track Medication Review Rejsction Reasan:
Allows M esver Prompt' For Medication Review

[ Prompt if was Undeliverable when Canceling an Rx

7
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When the option ‘Prompt for Medication Review’ is enabled, the system screens each patient
for Medication Review eligibility every time an Rx is processed. If the patient is eligible, the user
is prompted and presented with a number of options as shown below.

& Select an Option E =

This patient may be eligible for the (SMMA) Initial Assessment Program.

| Add to Med Review Queue |

| Do not prompt me until the next time the patient comes in. |

| Do not prompt until ... |

| Mever Prompt for this patient |

| Undecided |

o Add to Med Review Queue: Selecting this option adds the Med Review record to the
Medication Reviews queue which can be accessed from the Patient record or
F9 — Workflow. See section ‘Completing Medication Reviews ‘Saved for Later’ for
further details.

e Do not prompt me until the next time the patient comes in: This will suppress
prompting for today. The next time the patient comes in to fill an Rx, you will be
prompted for the Medication Review.

e Do not prompt until: This will allow you to dismiss the prompt for a specified number of
days, or until a specified date, after which the prompt will appear.

e Never prompt for this patient: This will suppress any further prompts for this patient.
This option is only available if the configuration option of Allow ‘Never Prompt’ for
Medication Review is enabled.

e Undecided: The prompt will re-appear once again the next time a prescription is filled
for the patient.
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Creating an Electronic Medication Review (Manual)
1. Bring up the patient card using the F3 Patient search.

2. Select Medication Review/Dialogs from the right navigation pane.

File Edit Patient Profile Reports Utilities Cards Session Help
F3 - Patient F5 - Drug F7 - Doctor I Fa - Workflow " F11 - Drop-off " F12 - New Rx " Alt-X - Start ]
Last Mame Dukes First Name George Salutation j oK Save Eatient
Profil
Address1 110 Bear Street Phone Numbers (1) (F2)(0ns)Bel - girthaate =
Description |Phone All Rxs
Address 2 Box 1260 Age
J Home (403) 762-1212 Active Rus
City Banff ~| Prov AB ~ Gender Male - i i
J - J No BicHEEREable Active Rxs w/Passtimes
Paostal TiL 141 Country Canada j Language English j
Refillable Rxs
Email Family Doctor Height 180 cm o X
= = Pricing Profile
Quick Code F2|| Weight 78 k [ 0o ] _]” 2
g 9 Not Disp./OTC Rxs
Comments (0) [F2] ns] (mel] ABBC - H
. Rxs Filled in Error
Topic Comment
Plans (0) Suspended Rxs
| subPlan Code] Group ID | Client 1D |Epiy |
Perform FDB Analysis
View
Alternate Addresses
- Batch
Allergies (0) General l Eamily | Copays | Communications | Other | Rl M-
R Charting
Patient Consent
Active Consent Unknown Consent
. Credit Cards
Al |
nimal - [0 Unit Dose D
Deceased On Type <None> - ocuments
Medical Conditions (1) Ins) o Medication Review/Dialogs
. e Prescriptions Cycle <Mone> -l

3. The Medication Review profile will appear. Click N — New Review/Dialog.

¥ 1-Patient - Dukes, George <0 =B é

File Edit Patient Profile Reports Utilities Cards Session Help

F3 - Patient F5 - Drug F7 - Doctor I F9 - Workflow " F11 - Drop-off “ F12 - New Rx " Alt-X - Start ]
Last Mame Dukes First Name George Salutation j oK Save Patient

N - New Review/Dial Profile
I - New Review/Dia ogl Al R
Medication Reviews (0) Active Rus
Tupe Status Fee Status Created ¥ |Completed | a || Active Rxs w/Passtimes
Refillable Rxs

4. The Medication Review/Dialog screen will appear. Select a review type from the dropdown
menu and click Perform Now. If you wish to add to the Med Review queue in order to
complete the Medication Review later, click Save for Later.

o Medication Review/Dialog = Py

Type  (SMMA) Initial Assessment j

Performuowl lgaveforlaterl [ XCanceI l
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5. The Medication Review Rx Selection screen will appear. Rxs under the Pre-Selected tab are
selected by default; Rxs on the other tabs are not. Proceed through each tab and check the
Rxs you want included in the report. When you are finished, click OK.

w° Medication Review Rx Selection P E|=B] X
Pre-Selected (3) | Other Rxs | Unfills | Not Dispensed | Discontinued
Rx Mum Drug Fill Date
1000958 Amoxicillin 50/ml 11-Jul-2014
1000957 Prinivil 2.5mg 11-Jul-2014
1000956 Synthroid 112mcg 11-Jul-2014
Select All ] ’ Select None ]
Drug lines to use in review
Drug line 1 Default j Drug line 2 Default j
v oK

6. The (SMMA) Initial Assessment screen will appear. Click Next to proceed through the tabs,
completing the required fields as you go.

NOTE: The type of review that is displayed on screen depends on what type of review was
selected in Step 4. In this example, the (SMMA) Initial Assessment screen appears.
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Questions

The Questions tab includes a list of questions that the pharmacist is to ask the patient to better
understand their situation. Answers are recorded by selecting the appropriate option from each
dropdown menu.

Questions I Medical History | Non-Prescription Medicationsl Rxs From Other Pharmacies | General Comments | Pharmacist Commr| * | *

.

Date of last SMMA or Updated SMMA 05/04/Z5EE]
Chronic Diseases - Ischaemic Heart Disease Mo j

Chronic Diseases - Hypertensive Disease Mo j

m

Chronic Diseases - Diabetes Mellitus Yes j

Chronic Diseases - Heart Failure Mo j

Chronic Diseases - Mental Disorders Mo j
Chronic Diseases - Asthma Mo j
Chronic Diseases - COPD Mo j

Symptoms or signs to be treated

=]
]
i
i}
=}
EF
~
=}
=
=5
=1
z
o
=1
3
8
=1

v affect the Clinical Pharmacist's decision

Medical History

The Medical History tab displays the medications that have been selected on the Medication
Review Rx Selection screen.

| Questionsl Medical History I MNon-Prescription Medications | Rxs From Other Pharmacies | General Comments | Pharmacist Comments|

Patient Medical History Ins
Currently Taking 7 TAB Synthroid 112mcg [KNO] Indications
Yes j Pink Round Tab Flint 112
Comments

Dr. Moultrie, Filipe
Last Fill Date: 14-Jul-2014, Days Supply: 7
TAKE 1 TABLET OMCE DAILY

Currently Taking 30 TAB Prinivil 2.5mg [MSD] Indications
Yes j Dr. Moultrie, Filipe
- . . Comments
Last Fill Date: 14-Jul-2014, Days Supply: 30

TAKE 1 TABLET EVERY MORNING

Currently Taking 7 ML Amoxicillin 50/ml [SNS] Indications
Yes j Dr. Moultrie, Filipe
Last Fill Date: 14-Jul-2014, Days Supply: 7 Comments

TAKE 1 TEASPOOM(SML)OMCE DAILY
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For each medication listed:

¢ Note if the patient is currently taking the specified medications and select Yes/No from
the dropdown list.

e Enter the reason for using the medication based on the patient’s feedback in the
Indications field.

e Enter any general comments in the Comments field.

Use the Del button to delete a record from the Medical History tab.

Non-Prescription Medications

The Non-Prescription Medications tab provides space to record any OTC/non-prescription
medications the patient is taking.

Click Ins to add a non-prescription medication to the tab.

Questions | Medical Historyl Non-Prescription Medications I Rxs From Other Pharmacies | General Comments | Pharmacist Comments

Non-Prescription Medications / Herbals / Supplements 1ns |[Del
Currently Taking  Claritin 10 mg For seasan allergies
Yes j

X save for Later @ Next

¢ Note if the patient is currently taking any OTC medications and select Yes/No from the
dropdown list.

e Enter the name of the medication in the Medication field.

e Enter any appropriate comments in the Comments field.

Use Del buttons to remove any OTC items.
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Rxs From Other Pharmacies

The Rxs From Other Pharmacies tab provides space to record medications that the patient is
taking that were filled in other pharmacies.

Click Ins to add an Rx from another pharmacy.

| Questions | Medical History | Non-Prescription Medications | Rxs From Other Pharmacies | General Comments | Pharmacist Comments|

Prescriptions From Other Pharmacies

From - Smith's Pharmacy - (555) - 123-4567

Currently Taking  Tylenol # 3 - Take 1 to 2 tablets up to 4 times a
Possible duplication of therapy

Yes j day when needed for pain

From - Duncan Mill Pharmacy - (355) - 555- 5555

Currently Taking  gisoprolol 5mg - take 1 tablet daily
Duplication of therapy

Yes -

Note if the patient is currently taking any other medications and select Yes/No from the

[ J
dropdown list.

e Enter the name of the medication in the Medication field.

e Enter any appropriate comments in the Comments field.

Repeat the same process for any Rx items that they have purchased from other pharmacies.

Use Del buttons to remove any Rx items.
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General Comments

The General Comments tab provides space to record any comments you want included on the
report printout.

| Questions | Medical History | Non-Preseription Medications | Rxs From Other Pharmacies | General Comments | pharmacist Comments |

Pharmacist Comments

The Pharmacist Comments tab provides space to record any comments that the pharmacist
wishes to enter concerning the medication or patient in the free form.

| Questions | Medical History | Non-Prescription Medications | Rxs From Other Pharmacies | General Comments | Pharmacist Comments |

10
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Assessment

The Assessment tab provides space to record any comments that the pharmacist wishes to
enter concerning the medication or patient in the free form.

| MNon-Prescription Medications | Rxs From Other Pharmacies | General Comments | Pharmacist Commentsl Assessment I

Therame Brablemicl and Barendial Adver FuramdefiF mevsd
erapy Problemy’s) and Potential Adverse Events(if any)

Dirirg TF
orug I'ne

X save for Later F# Finalize Review

7. When you are finished click Finalize Review.

8. The Medication Review prompt will appear. If you have Allow Editing Counseling Time
enabled, enter the amount of time it took to complete the review in the Time spent field.

The Assessment Location information is pre-populated with the pharmacy information. If
the Medication Review was physically conducted in another location (LTC facility, patient’s
home) other than the pharmacy, enter the name of the location and the address. Complete
the Other Professional Involved fields if another health professional assisted with the
review.

When you are finished, click OK.

11
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=¥ Medication Review & PY

Time spent: 00:30 On 14/07/2014 By Pharmacist (P) j

Assessment Location

Name Kroll Pharmacy
Address 220 Duncan Mill Road, Suite 201, Toranto, ON M3B 315

Other Professional Invaolved

MName T
Title Technician

Phone

| «ox | [XCanceI]

Affixing an Electronic Signature

NOTE: If you do not have an electronic signature configured, print the Medication Review
Report, have both the patient and the pharmacist sign the report, and scan it back into the
system.

9. Have the patient sign his or her name on the electronic signature tablet. Click the OK button
on the signature tablet.

12
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The patient signature appears once the patient signs on the electronic signature tablet.

10. Have the pharmacist sign the electronic signature tablet.

N

11. When you are finished, tap Done on the signature tablet.

Printing a Medication Review

12. A prompt will appear asking if you want to print a paper copy of the electronic Medication
Review. Click Yes.

13. The Medication Review report print form will appear. Select the appropriate print options
and click Print and provide this copy to the patient.

13
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A

Billing a Medication Review

14. Once printing is complete, the Fee For Service claim will automatically populate in the F12
screen. If necessary, perform a doctor search to locate the pharmacist to use as the
prescriber and ensure all of the other information entered on the F12 screen is correct.

NOTE: If the user account of the pharmacist logged into the terminal during the processing
of the Medication Review includes a license number that is identical to the license number of
a Prescriber card in the Doctor file, then the Prescriber field on the F12 screen for the claim
will be populated with that prescriber.

15. Click F12 - Fill Rx. The claim will be transmitted to the appropriate party for payment.

o 1-MNew Rx for Dukes, George
File Edit Rx View Labels Profile Reperts Utilities Cards Session  Help
| F3 - Patient H F5 - Drug H F7 - Doctor ‘ Fa - Workflow F11 - Drop-off I F12 - Fill Rx ” Alt-X - Start ‘
= = First Fill Last Fill Information
0/ NewRx Pending Adj os/08/14 || 0 0 Qty $0.00 Init [ & Lookup ” X Cance||
Priority Default Wait Time ﬂIF__ZI Due in 19 mins Forward Rx 'F2| Work Order 3 @ Delivery Pickup j
Patient Search Drug Search | Pack J Doc Search Loc Office j
MName | Dukes, George Agedl6 |Brand Mame | Dr. Pharmacist, Test
Address | 110 Bear Streat Male Generic Address 100 King Street
City Banff Prov |AB Pack Form Sched City Toronto Prov ON
Phone |Home (403) 762-1212 Purch OnHand 0 Mo image || Phone |(555) 555-5555
Flan Client 1D DIN Min Qty 0 Lic# 12345 Alt. Lic®
Alleraies Sig (SMMA] Initial Assessment Wit PM |PM Auth Qty o
(SMMA) INITIAL ASSESSMENT Disp Oty Refills(+) Rem Qty 0
G.P. % 0
Days 1
. Acq Cost
Conditions Prod Sel 3 - Pharmcj Cost 50.00
Asthma, unspecified, with stated status asthm: ] oW erttf ﬂ Markup 50.00
Reute of Admin j Label 1 [Fz
SadEs Fee 50.00
o=an=lomn -l Total 50.00
Plans | pricina |l Dates| Comments| Indications | Images || Other| [€ctrl [ | Warnings | Counselling Unit Dose (Ctrl-U): Disabled

14
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Medication Review Options

Several Medication Review options are available from the right navigation pane on the (SMMA)
Initial Assessment screen.

File Edit MedReview View Profile Utilities CentralFill Cards Session Help

F3 - Patient F5 - Drug F7 - Doctor F9 - Workflow F11 - Drop-off F12 - New R: Alt-X - Start

(SMMA) Initial Assessment Reviewed With | Doe, Jane (In Person) Review

Print Medication Review
Patient | Doe, Jane Address | 100 Yonge 5t

Birth 01/01/1980 | 34 years Female | Plan | ODB ClientID | 1111

Select Rxs for review
Phone | Cell (555) 555-5555 View Follow Ups
Allergies Conditions View

Patient Charting
Patient Documents

Patient Med Reviews (8)

Questions | Medical History | Mon-Prescription Medications | Rxs From Other Pharmacies | General Commentsl Pharmacist Comments Profile

L] AR

Have you received a MedsCheck review from another pharmacy in the last 12 months <Mat Answered=> j Active R
Medical Devices - BP Machine <Maot Answereds j Active Ris w/Passtimes
Medical Devices - Glucometer <MNot Answered> j Pricing Profile

Medical Devices - Aero Chamber <Mot Answereds> j Mot Disp/OTC Profile

Review
Print Medication Review
When this option is selected, the Medication Review report screen will appear, allowing you to

set various print options. Configure the appropriate print options. Select Preview to view the
report or Close to exit.

o Medication Review Report ((SMMA) Initial Assessment, 2014-Aug-06) =] s
File

Options

["] Print store logo
[T] Frint Drug Manufacturer
Print Pharmacist comment

Printer j Copies 15

Tray j [¥] collate  [C] Duplex

Festore Defaults] I o Erint ] [ Preview l [ X C|DSE!]

15
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Select Rxs for review

If you wish to add/edit Rxs on the Medical History tab, click the button Select Rxs for review.
When selected, the Medication Review Rx Selection screen will appear, allowing you to add
and remove items from the Medical History tab on the Medication Review Annual Review
screen. Click OK to save any changes and Cancel to close the screen.

« Medication Review Rx Selection ®B|leo B =
Pre-Selected (3) | Other Rxs | nfills | Not Dispensed | Discontinued
Rx Num Drug Fill Date
¥| 1000962 Synthroid 112mcg 14-Jul-2014
v} 1000961 Prinivil 2.5mg 14-Jul-2014
‘ v| 1000960 Amoxicillin 50/ml 14-Jul-2014
\ Select All || Select None |
Drug lines to use in review
Drug line 1 Default ~| Drugline 2 pefault ~
Lok | | X cancel|

View Follow Ups

When this option is selected, the Medication Review Follow-ups screen will appear, allowing
you to create follow-up reviews for the patient.

NOTE: This is something that you initiate to follow up with the patient after the Medication
Review has been completed. This is NOT a Medication Review Followup review.

& Medication Review Follow-ups ETSEES| ==
Medication Review
Type  (SMMA) Initial Assessment Completed On 06/08/2014
Patient Dukes, George Completed By PM

Follow-ups (0) [F2] [1ns] (D=
Due Date (Reason Brand Name FaxNum |Resulved | -

16
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To add a follow-up, click Ins and complete the Medication Review Follow-up screen. When you

are finished, click Save.

o Medication Review Follow-Up

Ko o[ :.IEI-'EhI

Medication Review

Type  (SMMA) Initial Assessment
Patient Dukes, George

) Do not follow up

1@/ Follow up required in days =

Reason Unknown

Comment

[“resohved on by
Comment

[ o Save l ’ XCanceIl

=

Completed On

Completed By

View

Patient Charting

When this option is selected, the Patient Charting form will appear, displaying information
about the patient’s weight, height, blood pressure, blood sugar, and so on.

240
230
220
210
200
190
180
170
160
150
140
130
120
110
100 :
a}---

80§

70f---

60 |
504

OlJantl 0fMarll 0agl  OMulll  O1Septl OfNlovil Ollani2 OWMari? OiMayi2 OlJullZ2  01Sepi2 OlhloviZ DJant3

|[eim ] X Cancel

w* Patient Charting
Weight :Haighl Blood Pressure | Blood Sugar | Cholesterol lCreatininsCL { INF: {Cluzanl
* Weight Values (3)
250 |Date Weight

15/01/2013 65
1040142012 60
08/01/2011 58

=

2
GEE

[F2) (1ng) [Del)

-

17
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Use the F2, Ins, and Del buttons to modify, insert, or delete information on this screen. Click
Print to print or Cancel to close the screen.

Patient Documents

When this option is selected, the Patient Document List will appear displaying a list of
documents associated with the patient.

Patient Document List [, Jlﬂ
i # [ Add Mew Document W
Documents [1]
Title Init  |Document Type|Created ¥ | Rietain Until |_-_‘
[ShMA] Initial Assessment banual lmpot | 20/08/2014

Use the F2, Ins, and Del buttons to modify, insert, or delete a patient document. Click Close to
exit the screen.

Patient Medication Reviews

When this option is selected the Patient Medication Reviews and Dialogs screen will appear,
displaying a history of all reviews for the patient including any that are currently in the

Medication Review queue.

<
%’ Patient Medication Reviews and Dialogs NS (B o @ &
|
I - New Review/D P - Print/Reprint F - Call uy C - Cancel Claim [
| F2- View Details D - Pharmacist Declined R - Patient Refused |
Medication Reviews (1) 7))
Type ISlalus |Fee Status ll:leaked M ICompleled I -
(SMMA) Initial Assessment Completed Electronic Pending Claim 06/08/2014 06/08/2014

Double-click a Medication Review to view its details. Click Close to exit the screen.

Profile

The Profile menu on the (SMMA) Initial Assessment screen is identical to the Profile menu on
the patient profile. This menu allows you to view All Rxs, Active Rxs, Active Rxs w/ Passtimes,

Pricing Profile, and Not Disp/OTC Profile.
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Completing Medication Review ‘Saved for Later’

1. To call up Medication Reviews ‘Saved for Later’ or added to the Med Review Queue via
auto prompting, do one of the following:

Patient Card

a) Bring up the patient card using the F3 Patient search and select Medication
Review/Dialogs from the right navigation pane.

b) The Medication Reviews queue will appear. Select the Medication Review record you want
to complete and click F - Call Up.

File Edit Patient Profile Reports Utilities Cards Session Help

F3 - Patient F5 - Drug F7 - Docto | F9 - Workflow H F11 - Drop-off || F12 - New Rx ” Alt-X - Start |

Last Name Dukes First Hame George salutation j oK Save x cancel Patient
Profile
N - New Review/Dialog P - Print/Reprint R
F2 - View Details D - Pharmacist Declined R - Patient Refused 5
Medication Reviews (2] (=) s] Active Rxs
Type |Status | Fee Status Created ¥ | Completed | a | Active Rxs w/Passtimes
{SMMA) Initial Assessment Pending Review Mot Completed Yet 06/058/2014 Refillable Rxs

F9 - Workflow

a) Select F9 - Workflow from the Alt-X Start screen and select Medication Reviews from the
right navigation pane.

b) The Medication Review queue will appear. Select the Medication Review you want to
complete and click F - Call Up.

File Edit Utilities NH Workflow Cards Session  Help

| F3 - Patient || F5 - Drug | F7 - Doctor | F9 - Workflow F11 - Drop-off F12 - New Rx Alt-X - Start
M d . t R . P - Print/Reprint £ Refresh Workflow Actions
edication reviews D - Pharmacist Declined R - Patient Refused  space - Mark Rxs Ri's To Do
Patient |Type | Status |Fea Status |Created | Completed | » | Rx'slnProgress
Dukes, George [SMMA]} Initial Assessment Pending Review Mot Completed Yet 07,/08/2014

Pending Adjudication (0)
Trouble (0)
Rx Counseling (2)

Medication Reviews (3)

2. Complete steps 3-8 of the Creating an Electronic Medication Review section.
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Sample Electronic Medication Review Report

(SMMA) Initial Assessment

Personal Medication Recordof Address

Dukes, George 110 Bear Street, Banff AB TIL1A1

DOoB Gender | Alberts Personal Health Care CardNumber Phone Diate of last SMMA or Updated SMMA
01-Apr-1908 M (403)762-1212 05-Apr-2013

Allergiss Conditions

N/A Asthma,unspecified,withstatedstatusasthmaticus

I:‘ Chronic Diseases - Hypertensive Disease
Chronic Diseases - Diabetes Mellitus

|:| Chronic Diseases - COPD

I:‘ Chronic Diseases - Asthma

I:‘ Chronic Disegses - Heart Failure

I:‘ Chronic Diseases -Ischaemic Heart Disease

|:| Chronic Disegses - Mental Disorders.

Listof Schedule1Drugs andi/orinsulin
Paxil

INFORMATION FOR ASSESSMENT

Symptomsorsignstobetreated

Treatn i ¥ ion, i i ugther: nes

Otherl € pI orotherpr: T theClinicalPharmacist'sdecision
Otherhealth: diti T ttheClinicalPharmacist'sdecision

Li Y swhichm ugtherapy,i i notlimi tob

Anvotherhealthinformnati bleClinicalPharmacistwould

equiretoperformthe Pharmacy Service

Has a CACP, SMMA or Physician CPP ever been completed for this Resident

Yes| Mo [ Has a CACP been completed for this Resident in this Service Year

|Yes | No

Have copies been obtained

Page 1 of 3
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(SMMA) Initial Assessment

Producflame Strength Form Prescriber Oty Fill Date Directionsforllse IndicationforUse
Xanax 1img TAB | Dr. Moultrie, Felipe 10| 06-Aug-2014 |TAKE 1 TABLET ONCE DAILY
Paxil 10mg TAB | Dr. Moultrie, Felipe 10 | 06-Aug-2014 | ASDIRECTED

DrugTherapyProblem(sJandPotentialAdverseEvents(ifany)

AppropriateResponse(s)toDrugTherapyProblem(sjandPotentialddverseEvents(ifany)

AgreedGoalsOfMedicationTherapy

ProgressMonitoringPlan

Generdlomments
General comments

Pharmacistomment

Pharmacist comments

LOCATION OF THE ASSESSMENT

Name Address

Page 2 0f 3
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(SMMA) Initial Assessment
Declarati dC toResid -

tResident'sPer- IR
| hereby confirm that:

ble)
# | have reviewed and discussed this SMMA/Updated SMMA with the Clinical Pharmacist who prepared it;

# |understand and accept the goals and potential risks of the medication therapy as outlined in this SMMA/Updated SMMA; and
# | have been provided with a copy ofthis SMMAJUpdated SMMA.

(] / \
/ v |
gt | O Som
Dukes, George Date
DeclarationofClinicalPharmacist
& | have personally seen and conducted an Assessment on Dukes, George forthe purpese of preparing, documenting
and reviewing this SMMA/Updated SMMA in accordance with the requirements setout in the Compensatien Plan for Pharmacy Services
ron -
\
| NP noutat v
Kroll Date
Registration#: 123124515

NOAdditionaPrescribingAuthority

Page 3 of 3
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Viewing a Completed Medication Review

With Electronic Signatures Enabled
1. Bring up the patient card using the F3 Patient search.
2. Select Medication Review/Dialogues from the right navigation pane.

3. Highlight the completed Medication Review and click F2 - View Details.

©¥ 1-Patient - Dukes, George S E=RE

File Edit Patient Profile Reports Utilities Cards Session Help

F3 - Patient F5 - Drug F7 - Doctor F9 - Workflow “ F11 - Drop-off “ F12 - Mew Rx “ Alt-X - Start I
Last Mame Dukes First Name George Salutation j oK Sove X cancel Patient

N - New Review/Dialog P - Print/Reprint F - Call up A:r:zl:

:

Medication Reviews [2] ATl Active Rxs

Type |Status | Fee Status Created ¥ |Completed | a | Active Rus w/Passtimes
[SMMA] Initial Assessment Pending Review Not Completed Yet 06/08/2014 Refillable Rxs

(SMMA) Initial Assessment Completed Electranic Pending Claim 06/08/2014 06/08/2014

Pricing Profile

4. The (SMMA) Initial Assessment screen will appear. Click the various tabs to see the
Medication Review information that has been entered.

Medication Review View LEJ [é]
(SMMA) Initial Assessment

Created 06-Aug-2014 12:04 PM | S5tatus | Completed Electronic Fee Status | Pending Claim Fee Rx N/A

Started 06-Aug-2014 12:04 PM Completed | 06-Aug-2014 12:22 FM Duration | 15 mins View Sigr

Reviewed By | Preetha Reviewed With | Dukes, George (In Person)

Questions | Medical History | General Comments | Pharmacist Comments | Non-Prescription Medications | Rxs From Other Pharm| ’I

-

Date of last SMMA or Updated SMMA 05/04,/2013

Chronic Diseases - Ischaemic Heart Disease No

5. Click Print to print the Medication Review, or View Signatures to view the pharmacist’s or
patient’s electronic signature.

Scanned Reviews with Manual Signatures
1. Bring up the patient card using the F3 Patient search.
2. Select Medication Review/Dialogues from the right navigation pane.

3. Highlight the completed Medication Review and click F2 - View Details.
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4. The Medication Review View screen will appear. The Review tab displays information
entered on-screen during the Medication Review; the Documents tab displays the scanned

image of the signed Medication Review. Scanned paper Medication Reviews is also viewable
from Patient Documents.

Medication Review View - —y * - 5] X
(SMMA) Initial Assessment
Created 30-Jul-2014 02:25 PM Status | Completed Electronic Fee Status Claimed FeeRx 1087677
Review | Documents
Started 30-Jul-2014 02:25 PM Completed | 30-Jul-2014 02:26 PM Duration 1mOs

Print
Reviewed By | Scott Belfer Reviewed With | Belfer, Scott (In Person)

Questions Medical History | Non-Prescription Medications | Rxs From Other Pharmacies | General ,C‘?",‘“,‘?"‘,S,I Pharmacist Comments |

Have you received a MedsCheck review from another pharmacy in the last 12 months No

Medical Devices - BP Machine Yes

Medical Devices - Glucometer Yes

5. Click Print to print the Medication Review.
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Paper Medication Reviews

This section explains how to perform paper Medication Reviews. Paper Medication Reviews

must be completed on paper, signed, and scanned back into the system.

NOTE: The automatic prompts will not appear if the patient does not meet the criteria for a
Medication Review. However, based on other available information and your professional
judgement, you can determine whether the patient might benefit from a Medication Review
and then manually create a Medication Review.

Configuring the Medication Review Prompt

The system prompts for Medication Review when the option Prompt for Medication Review is
enabled under File > Configuration > Store > Rx > Prompting.

F
o Store Level Configuration Parameters

(53] =5c=

| Genelall F'atientl Drug | Doct0r|

A= | FDB | Adiudicationl Labelsl Heportsl Securit_l,ll Interfacesl Dlderl X-AHI Y -To D0|

[ ctrl (=

1- Generall 2 - Pricing| 3~ PleDtinQ| 4 - Mursing Homel 5 - Background Rx FiIIingI E- Workflowl 7- Eounselingl 8- EeFlH|

Prampt ta use Drug Subs [ Autamatically use Diug Subs
Usge Drug Subz when B atching
Frompt If Doctor Refused Repeat When Canceling R
Prompt far Comments when Cancelling an Rx
[ Always require comment
[ Prompt for Comments when Inactivating an Rx
[ Always require comment
[ Prampt for Patient Coungelling on new R
[ Prompt ta Batch NH Rxs
Prompt when not dispensing as dug's Pack Size
Prompt For Repeats When Copying an Rx
Prompt To Use Manual Price From Last Refil
[ Remave Manual Price far Batched Rxs
[ Prompt if Dactar Autharization Received for Marcotic Rxs
[ Check far High Intensity Drugs
Prompt if there iz not enough inventary to fill the Rx
[ Prewvent Copying an Inactive Rx to a Mew Mumber
[ Show local patient profils on fill
Frompt to Copy "Migtake" Rxs ta a Mew Mumber
[ Shaw thermal/dat matrix label config on autofil

rompt to Frint Scrpt Image far 1zt Fill of an Unfilled R+

P Pritit 5 cript | far 1st Fill of an Unfiled R
rarmpt far lan [nfarmation i number iz zet
P for &40 L Plan [nf ior if S8 ber is NOT

[ Prampt if Was Undeliverable when Canceling an Rx

Drug Programsz
[] Participate in the Fix Canada / Health Inform Pragram

[] Participate in the Pharmacy Access program
[ Use Station Mame Subdirectaries For Pharmacy Access
Days Back: 365

[] Enable Rx Canada Program [FxG ateway]

Services
[ Prampt ta Enral Patients in Refil Reminder or Auto Refill Frogram
Frampt ta Enral MH Patients in Refil Reminder or Auta Refil Program
Prampt ta Enable Rxs for Refill Reminder and Auta Refill Pragram

Enrol Patients for Pickup Matification Ma j
Enral HH Patients far Pickup Motification Mo ﬂ

Frampt to copy work flow packaged info for cancel and refill Rxs
Frampt to copy to new number if refiling an Fix with no repeats
[ Prampt for Due Date on autafil batches

[] Prompt for Tx comment on autafil batches

Save Route code from Fx a3 default value if no default is set Ask j

Save Fomn code from Aix a3 default valus if no default iz set Ask j

Track Medication Review Rejection Reason:
Aoy M ever Prompt’ For Medication Review

I [¥] Prompt for Medication R eviewl

7
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When the option ‘Prompt for Medication Review’ is enabled, the system screens each patient
for Medication Review eligibility every time an Rx is processed. If the patient is eligible, the user
is prompted and presented with a number of options as shown below.

w? Select an Opticn E XS

This patient may be eligible for the (SMMA) Initial Assessment Program.

[ Print Report Now J
[ Print Report Later ]
[ 1 have Other Rxs to fill for this patient ]
[ Do not prompt me until the next time the patient comes in. ]

I Do not prompt until ... J

| Never Prompt for this patient |

e Print Report Now: This will call up the Medication Review report so you can select the

items you would like to print on the report.

e Print Report Later: This places a record in the Medication Review queue allowing you to
print the Medication Review at a later date or time. See section ‘Completing Medication

Reviews ‘Saved for Later’ for further details.

e | have Other Rxs to fill for this patient: This will allow you to continue filling more Rxs

for the patient before printing the report.

e Do not prompt me until the next time the patient comes in: This will suppress
prompting for today. The next time the patient comes in to fill an Rx, you will be

prompted for the Medication Review.

e Do not prompt until: This will allow you to dismiss the prompt for a specified number of
days, or until a specified date, after which the prompt will appear.

e Never prompt for this patient: This will suppress any further prompts for this patient.
This option is only available if the configuration option of Allow ‘Never Prompt’ for

Medication Review is enabled.
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Creating a Paper Medication Review (Manual)
1. Bring up the patient card using the F3 Patient search.

2. Select Medication Review/Dialogs from the right navigation pane.

File Edit Patient Profile Reports Utilities Cards Session Help
F3 - Patient F5 - Drug F7 - Doctor l F9 - Workflow " F11 - Drop-off “ F12 - New Rx " Alt-X - Start I
Last Name | Dukes First Name  George Salutation | ok Save Patient
Profil
Address1 110 Bear Street Phone Numbers (1) Birthdate i
Description |Phone | All Raes:
Address 2 Box 1260 Age
J J Home (403) 762-1212 J Active Rus
City Banff ~| Prov AB « Gender Male hd i i
- No IganeEagable Active Fxs w/Passtimes
Postal TiL 141 Country Canada j language English j
Refillable Rxs
Email Family Doctar Height 180 cm .
Pricing Profile
Quick Code weight 78 kg toad |[ pelete | Not Disn/OTC R
ot Disp./ s
Comments (0) ABBC
. Rxs Filled in Error
Topic Comment
Plans (0) Suspended Rxs
| SubPtan Code| Group ID | Client 1D |Biy |
Perform FDB Analysis
View
Alternate Addresses
- Batches
Allergies (0) [F2) (In) (0=l General \ Eamily ] Cgpa}lél Cgmm!r"cat‘gnsl Other 1 ECtrIB
. Charting
Patient Consent
Active Consent Unknown Consent
Credit Cards
Al |
nimal [ Unit Dose o .
Deceased On Type <None> j ocuments
Medical Conditions (1) (F2] (Ing] [Tel] o Medication Review/Dialogs
- . Prescriptions Cycle <Nonex ~|

3. The Medication Review queue will appear. Click N — New Review/Dialog.

File Edit Patient Profile Reports Utilities Cards Session Help

F3 - Patient F5 - Drug F7 - Doctor [ F9 - Workflow “ F11 - Drop-off " F12 - New Rx " Alt-X - Start I

Last Mame Dukes First Name George salutation j oK Save Patient
Profile
N - New Review/Dialog

All Rxs
Medication Reviews (0] T Active Res
Type Status | Fee Status Created ¥ | Completed | + || Active Res wyPasstimes
Refillable Rxs

4. The Medication Review/Dialog screen will appear. Select a review type from the dropdown

menu and click Print Now. If you wish to add to the Med Review queue in order to print the
Medication Review later, click Save for Later.

o Medication Review/Dialog 1B e

R (SMIMA) Initial Assessment j

I Print Mow I lgaveforlaterl l X cancel ]
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5. The Medication Review Rx Selection screen will appear. Rxs under the Pre-Selected tab are
selected by default; Rxs on the other tabs are not. Proceed through each tab and check the
Rxs you want included in the report. When you are finished, click OK.

¥ Medication Review Rx Selection e =B8] =
Pre-Selected (3) | Other Rxs | Unfills | Mot Dispensed | Discontinued
Rx Mum Drug Fill Date
1000958 Amoxicillin 50/ml 11-Jul-2014
1000957 Prinivil 2.5mg 11-Jul-2014
1000956 Synthroid 112meg 11-Jul-2014
Select all ] [ Select None ]
Drug lines to use in review
Drug line 1 Default j Drug line 2 Default j
7ok

6. The Medication Review Report form will appear. Select the appropriate print options and
click Print. The report will generate.

Complete the Medication Review on the form. Sign the Medication Review Report and
have the patient do the same.

28



%KROLL

Computer Systems Inc

Medication Reviews — Alberta

Scanning Medication Review Reports

8. From the Alt-X Start screen, go to Utilities > Printed Document Scan/Import.

File Edit Reports [Utilities | Central Fill Cards Session

Help Version 10

F3 - Patient [

Last Rx Numbers

1000
9000
Modify R

Reprint R

Cancel Ry

Modify Specifi
Reprint Specifi
Counsel R

Drug Ordering
Merge

Unmerge

Adjust Current Wait Time
Check Interactions
Quick Price

Delivery Orders

View Mail/Messages

View Packager Batches

View Pending Metwork Queue
Labels

Script Reentry Mode

Credit Card Password Manager
Database Maintenance

Drug

Patient/Rx Import

Y }kﬂow " F11 - Drop-off " F12 - New Rx “ Alt-X - Start ]
3

Alt+=

Followups

0-1hrs  1-4 hrs 4+ hrs  Tomarrow  Trouble Total
0 0 0 0 0 4 R Counts
Mew Rxs 0
0 0 0 0 0 4 Repeat Rxs 0
3
Total Rxs 0

Printed Document Scan/Import

9. The Import Scanned Documents screen will appear. Place the report pages face down on
the scanner hopper. Check Scan both sides of paper if you are scanning pages with
information on both sides and your scanner supports dual side scanning. Click Start

Scanning.

7
Import Scanned Documents

B~

Scanner
Scanner
Mode

Resolution 100

FUJITSU fi-6130dj
Colour

IScan bath sides of paper [[] I

Document Processing
To Process 0

To Reconcile @

Wiew Scan History

[ Process and Reconcile ]
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10. When scanning is complete, the screen will indicate how many pages were scanned

successfully and how many will need to be manually reconciled. When you are finished,

click Process and Reconcile.

Impart Scanned Documents | E || =

Scanner

Scanner  FUJITSU fi-6130Zdj #2

Maode Colour
Resolution 100 Scan both sides of paper [

Document Processing

To Process 0 I Process and Reconcile I

To Reconcile @

Wiew Scan History

11. The Document Scan Reconciliation screen will appear. Items ready to be processed will

appear in the Documents to be created section. Items that need to be reconciled will
appear in the Unprocessed Images section.

& Document Scan Reconciliation @ Beo @ =
Documents to be created (1)
Scanned on Status Fied By Tyvpe Tithe Patient RxMum | Pages| Message -
B F|zoms00 »QAQAODDBE S B Unprocessed Images (0), Current Document
» | Document Images [2) (el (A4 [~
Scanned On{ Type # Info Message -
1231:43 | Patient Med Revied 1/
(EMIA) Detiol Asoassruant 1231:45  Patient Med Reviet 2
e
Dekes, foorge 116 BearSteet b AR TIL 1AL
2] Tene [ Do mw srareem Daw Lathomte == Yan oFar T o Leaana TRRT E
01-Ap- 1908 I L} I (i mn2 5-AR-2013
lf:" ;ﬁ;’;ﬂk\:ﬁﬂﬂﬂlm
gcr c Daees- Froeiesset Daees Lea ot Pl Br s aruSca ieasins.
W Crvonc Duensat - Dabries ity fad
crvonc Daseae 0%
Cmane Dnninn . Latees
] rvonc Bassees - naat vt
e ]
[ —
HFDAMATION FOR ASSESSMENT I
T
c
Document Type Patient Med Review |
. Patient @
Y ¥ Name Doe, Jane DOB 24/10/1950
[ R0, i oy % o s ot 5 o |0 e e e e T P T[] Address 200 Main St
[Fren e cearms [iwa ] City, Prov Banff, AB
[ ﬁ Med Review
11/07/2014 - (SMA) Initial Assessment (Printed Paper) j
[Brightness Contrast Saturation
0 0 0 [ X cancel ( o Next ]
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12. If all Rxs were scanned successfully and appear in the Documents to be created section,
click the Process Pending Documents button. Click Cancel to close the screen.

Billing a Medication Review

13. Once scanning is complete, the Fee For Service claim will automatically populate in the F12
screen. If necessary, perform a doctor search to locate the pharmacist to use as the
prescriber and ensure all of the other information entered on the F12 screen is correct.

14. Click F12 - Fill Rx. The claim will be transmitted to the appropriate party for payment.

Completing Medication Review ‘Saved for Later’

1. To call up Medication Reviews ‘Saved for Later’, do one of the following:

Patient Card

a) Bring up the patient card using the F3 Patient search and select Medication
Review/Dialogs from the right navigation pane.

b) The Medication Reviews will appear. Select the Medication Review record you want to
complete and click F - Call Up.

File Edit Patient Profile Reports Utilities Cards Session Help
F3 - Patient F5 - Drug F7 - Docto | F9 - Workflow || F11 - Drop-off || F12 - New Rx ” Alt-X - Start |
Last Name Dukes First Mame George Salutation j QK Save X cancel Patient
Profile
N - New Review/Dialog P - Print/Reprint Al Rae
F2 - View Details D - Pharmacist Declined R - Patient Refused Active Foc
Medication Reviews (2] [F2) @ me) TE
Type | Status | Fee Status |Created ¥ | Completed | ~ || Active Rus w/Passtimes
[SMMA] Initial Assessment Pending Review Mot Completed Yet 06,/08,/2014 Refillable Rxs

F9 - Workflow

a) Select F9 - Workflow from the Alt-X Start screen and select Medication Reviews from the
right navigation pane.

b) The Medication Review queue will appear. Select the Medication Review you want to
complete and click F - Call Up.

File Edit Utilities NH Workflow Cards Session Help

F7 - Doctor | F9 - Workflow F11 - Drop-off F12 - New R Alt-X - Start

Medication Revi P - Print/Reprint 22 Refresh Workflow Actions
edication Reviews D - Pharmacist Declined R - Patient Refused  space - Mark Rxs R's To Do

Patient |Type |Status |Fee Status |Created |Comp|eted| + || Re'sInProgress
Dukes, George [SMMA] Initial Assessment Pending Review Mot Completed Yet |07/08/2014

| F3 - Patient ” F5 - Drug |

Pending Adjudication (0]

2. Complete steps 4-14 of the Creating a Paper Medication Review section.
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Sample Paper Medication Report

Personal Medication Record of
Dukes, George

(SMMA) Initial Assessment

Address
110 Bear Street, Banff AB T1L 1A1

DOB

01-Apr-1908

(403) 762-1212

Phone ‘ Date of last SMMA or Updated SMMA

Representalive Address

‘ Represe. ve Phone

Allergies
N/A

Conditions
Asthma, unspecified, with stated status asthmaticus

D Chronic Diseases - Hyperiensive Disease
D Chronic Diseases - Diabetes Mellitus

I:l Chronic Diseases - COPD

I:‘ Chronic Diseases - Asthma

D Chronic Diseases - Heart Failure

D Chronic Diseases - Ischaemic Heart Disease
D Chronic Diseases - Mental Disorders

INFORMATION FOR ASSESSMENT
Symptoms or signs to be treated

List of Schedule 1 Drugs andior Insulin
Paxil

Treatment history for the condition, including drug therapy and outcomes

Other health conditions that may affect the Clinical Pharmacist's decision

Other health care products aids and devices or other preducts being used that may affect the Clinical Pharmacist's decision

Lifestyle factors which may affect drug therapy, including but not limited to caffeine, tobacco, alcohol usage

Any other health infomation that a reasenable Clinical Pharmacist would require to perform the Pharmacy Service

Page 10f 3
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(SMMA) Initial Assessment

Has a CACP, SMMA or Physician CPP ever been completed for this Resident Yes| Mo | Has a CACP been completed for this Resident in this Service Year | Yes| Mo |
Have copies been obtained Yes| No
Product Name ‘ Strength ‘ Form ’ Prescriber { Qty ‘ Fill Date ‘ Directions for Use ‘ Indication for Use
Xanax img TAE | Dr. Moultrie, Felipe 10| 06-Aug-2014 | TAKE 1 TABLET ONCE DAILY
Paxil 10mg TAB | Dr. Moultrie, Felipe 10| 06-Aug-2014 | AS DIRECTED
Drug Therapy Problem({s) and Potential Adverse Events(if any)
Appropriate Response(s) to Drug Therapy Problem(s) and Potential Adverse Events(if any)
Agreed Goals Of Medication Therapy
Progress Monitoring Plan
General Comments ‘
LOCATION OF THE ASSESSMENT
Nams Addrass ‘
Page 2 of 3
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(SMMA) Initial Assessment

's Personal Rep tive (if applicable)

Declaration and Consent of Resider
I hereby confirm that-
# | have reviewed and discussed this SMMA/Updated SMMA with the Clinical Phammacist who prepared it:
# | understand and accept the goals and potential risks of the medicafion therapy as ocutlined in this SMMA/Updated SMMA; and
& | have been provided with a copy of this SMMA/Updated SMMA

Date
Declaration of Clinical Pharmacist
* | have seen and an on Dukes. George for the purpose of preparing, documenting
and reviewing this SMMA/Updated SMMA in accordance with the requirements sef out in the Compensation Plan for Pharmacy Services
Kroll Date
Registration #:
Additional Prescribing Autherity: || ves [ | Mo
OTHER PROFESSIONAL INVOLVED IN CARE
Name Title Phone
Page 3 of 3
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Viewing a Completed Medication Review

1. Bring up the patient card using the F3 Patient search.
2. Select Medication Review/Dialogs from the right navigation pane.
3. Highlight the completed Medication Review and click F2 - View Details.

4. The (SMMA) Initial Assessment screen will display the scanned image of the completed
Medication Review. Scanned Medication Reviews are also viewable from Patient

Documents.
Medication Review View - — - [B]] =
(SMMA) Initial Assessment
Created 30-Jul-2014 02:34 PM Status | Completed Paper Fee Status | Claimed FeeRx | 1087678

2014-07-30 2:33 PM |

B @@ zmoss % Q @[O0 0 G G613

(SMMA) Initial Assessment

m

(SMMA) Initial Assessment

110 Bear Stroct, Bant AR TIL 1AL

1403} 7631313 l

o5-Apr-3013
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A

Declined and Refused Medication Reviews

This section explains the process for recording Medication Reviews that have been declined by
the pharmacist or refused by the patient.

NOTE: The medication review records that are declined by the pharmacist or patient refused
can also be noted from the Medication Review queue on the F9-Workflow screen.

Pharmacist Declined
1. Bring up the patient card using the F3 Patient search.
2. Select Medication Review/Dialogs from the right navigation pane.

3. Select the appropriate Medication Review and click D — Pharmacist Declined.

o 1-Patient - Dukes, George

File Edit Patient Profile Reports Utilities Cards Session Help

F3 - Patient FS - Drug F7 - Doctor | F9 - Workflow ” F11 - Drop-off H F12 - Mew Rx ” Alt-X - Start ‘
Last Name  Dukes First Name George Salutation j oK Save X cancel
N - New Review/Dialog P - Print/Reprint
F2- View Details |D - Pharmacist Declined| R - Patient Refused
Medication Reviews (2] [[F2] (Ins] (Del]
Type |Status |Fee Statuz |Created ¥ | Completed | -
[SMMA) Initial Assessment Pending Review Mot Completed Yet 06/08/2014

4. Select the appropriate option from the Decline/Refuse prompt.

o Select an Option

(53] ==c=

Decline/Refuse - (SMMA) Initial Assessment.

| Do not prompt until the next time the patient comes in. |

| Do not prompt until ... |

| Mever Prompt for this patient |

| Cancel |

e If you select Do not prompt until the next time the patient comes in, no further action
is required until the next time the patient visits the pharmacy.

e [f you select Do not prompt until... you will be prompted to specify the next time you
want to be prompted for the patient’s Medication Review. Complete the form and click

OK.
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e [f you select Never Prompt for this patient you will not receive any additional
Medication Review prompts for the patient.

Patient Refused

1. Bring up the patient card using the F3 Patient search.
2. Select Medication Review/Dialogs from the right navigation pane.

3. Select the appropriate Medication Review and click R — Patient Refused.

o 1-Patient - Dukes, George

File Edit Patient Profile Reports Utilities Cards Session  Help

F3 - Patient F5 - Drug F7 - Doctor ‘ Fo - Workflow ” F11 - Drop-off H F12 - Mew Rx ” Alt-X - Start ‘
Last Mame Dukes First Name George Salutation j oK Save X cancel
N - New Review/Dialog P - Print/Reprint
F2 - View Details D - Pharmacist Declined R - Patient Refused
Medication Reviews [2] [FZ] (Ing] [Del]
Type |Status |Fee Statuz Created ¥ | Completed | -
[SMMA) Initial Assessment Pending Review Mot Completed Yet 06/08/2014

4. Select the appropriate option from the Decline/Refuse prompt.

o Select an Option @lél

Decline/Refuse - (SMMA) Initial Assessment.

| Do not prompt until the next time the patient comes in. |

| Do not prompt until ... |

| Mever Prompt for this patient |

| Cancel |

e [f you select Do not prompt until the next time the patient comes in you will be

prompted to specify if the review was declined by the Patient or Someone Else.

o If you select Someone Else, the Medication Review/Dialog Refusal form will
appear. Click the lookup button next to the Select agent field to search for the
patient who refused the review. Select a relationship from the Relationship to
patient menu and click OK.
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¢ Medication Review/Dialog Refusal

Refused By _) Patient @ Someone Else

Select agent Doe,Jane j
Last name Doe

Eirst name Jane

Relationship to patient@ vl

I oK I IXCanceI‘

o No further action is required until the next time the patient visits the pharmacy.

e [f you select Do not prompt until... you will be prompted to specify the next time you
want to be prompted for the patient’s Medication Review. Complete the form and click

OK.

e If you select Never Prompt for this patient you will not receive any additional

Medication Review prompts for the patient.

from the Medication Reviews queue.

NOTE: Medication Review records that have been refused or declined cannot be deleted

Medication Review Statuses

This section explains the statuses that appear in the Medication Review queue at various

stages throughout the Medication Review process.

File Edit Patient Profile Reports Utilities MNH Cards Session Help
F3 - Patient F5 - Drug F7 - Doctor F8 - Workflow “ F11 - Drop-off “ F12 - New Rx “ Alt-X - Start ‘
Last Mame Dukes First Name Geaorge salutation j oK Save x cancel Patient

N - New Review/Dialog
F2 - View Details
Medication Reviews (7]

P - Print/Reprint
D - Pharmacist Declined

F - Call up
R - Patient Refused

Type Status Fee Status Created ¥ | Completed |
[SMMA) Initial Assessment Pending Review Mot Completed Yet 19/08/2014

[SMMA] Initial Assessment Frinted Paper Review Mot Completed Yet 31/07/2014

[SMMA) Initial Assessment Completed Electronic Pending Claim 06,/08/2014 | 06/08,/2014
[SMMA] Initial Assessment Declined by Pharmacist Mo Fee Applicable 11/07/2014 |11/07,/2014
[SMMA) Initial Assessment Refused by Patient No Fee Applicable 19/08/2014 | 19/08/2014

[F2) (ing) [0=)

-

m

Profile

All Ras

Active Rxs

Active Rxs w/Passtimes
Refillable Rxs

Pricing Profile

Mot Disp./OTC Rxs

Byg Filled in Frror

Pending
Reviews that have been initiated but have not yet been completed.

Printed Paper
Reviews that have been printed but have not yet been billed.
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Completed
Reviews that have been printed and billed.

Declined by Pharmacist
Reviews that have been declined by the pharmacist.

Refused by Patient
Reviews that have been refused by the patient.

Fee Statuses

File Edit Patient Profile Reports Utilities NH Central Fill Cards Session Help
F3 - Patient F5 - Drug ETE T Fa - Workflow “ F11 - Drop-off “ F12 - New Rx “ Alt-X - Start

Last Name Doe First Name Jane Salutation Ms. j I oK 3 X cancel Patient
o . o - ~ ¥ Profile

N - New Review/Dialog P - Print/Reprint F - Call up C - Cancel Clain All Res

F2 - View Details D - Pharmacist Declined R - Patient Refused Active For

Medication Reviews (3) | Active R

Type [ Status Fee Status Created ¥ |Completed | ~ | Active Rxs w/Passtimes

{SMMA) Initial Assessment Pending Review Not Completed Yet 19/08/2014 Refillable Rxs

[SMMA] Initial Assessment Refused by Patient Mo Fee Applicable 19/08/2014 19/08/2014 o 5

(SMMA] Initial Assessment Completed Electronic Pending Claim 06/08/2014  06/08/2014 =|||| Pricing Profile

Review Not Completed Yet
Reviews that have been initiated but have not yet been completed.

No Fee Applicable
Reviews with no associated fees (usually declined or refused reviews).

Pending Claim
Electronic reviews: Completed reviews with a Status of Completed.
Paper reviews: Reviews that have been printed and the option Require Document scan to

complete Paper Med Review is off, and reports that have been printed and scanned back into
the system if this option is enabled.
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